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CHAPTER 1 INTRODUCTION 
 

1.1     WARRANTY 
 

All rights to this product are reserved by AXION CONTROL SYSTEMS Pty Ltd. This copy of the 

product is intended for use by the original purchaser and only for use on a single computer system. 

Registered users of this product are only licensed to copy the program from disk for security 

purposes. Unauthorised copying, duplicating, selling or otherwise distributing this product is a 

violation of the law. 

1.2 PUBLISHING RIGHTS 
 

Every effort has been made to supply complete and accurate information. AXION CONTROL 

SYSTEMS Pty Ltd, however, assumes no responsibility for the product use, or any infringement of 

the intellectual property rights of third parties ensuing from its use. AXION CONTROL SYSTEMS 

Pty Ltd reserves the right to make periodic changes, revisions, enhancements and alterations of any 

kind to the product and its manuals without obligation to notify any person(s), institution, or 

organisation of such changes, revisions, enhancements and alterations. 

1.3 COPYRIGHT 
 

© 2009 AXION CONTROL SYSTEMS Pty Ltd 

Phone: +61 3 9555 3355 

Web: www.axioncs.com 

Email: axibatch@axioncs.com 

 

© 2009 All rights reserved       Revision_07.06 (Ec) 
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1.4 WINDOWS ENVIRONMENT 
 

As with any Windows product insertion of data is predominantly carried out via the mouse by 

clicking and to a lesser extent by using the keyboard. Once the main data is entered such as 

customers, mix design, materials etc…, minor entry of information is carried out via the keyboard. 

 

Accessing the relevant areas of the program is undertaken by clicking on the relative folder (menu) 

or icons.  

 

The flexibility of WINDOWS allows the operator to enter a particular field by either right clicking 

the mouse (depending on the location), clicking on a folder or one of the menus commands. These 

locations will be discussed throughout the manual. 

 

In any PC based industrial control system it is strongly recommended that periodic backing up of the 

data base is carried. This avoids losing significant amounts of information in the event of power 

surge, hardware damage etc… 

1.5 KEYBOARD & MOUSE ENVIRONMENT 
 

As previously mentioned accessibility is achieved by using either the mouse or the keyboard. Once 

in the program the menus can be accessed by either clicking the mouse whilst the pointer is over the 

particular title or by holding the Alt key and typing the underlined first letter (Eg. Alt + F) of the 

menu group. This opens up the relevant menu and enables the user to further select the relevant area 

by either using the mouse, the arrow keys on the keyboard or the Alt + letter. 

 

The operator will gain experience using a combination of both functions to skilfully move around 

the screen, enter information and select functions. 
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1.6 AXI-INVOICER SOFTWARE ENVIRONMENT 
 

To optimise the potential of the program it is important to understand the basic layout of the 

AxiInvoicer screen. The main screen (Figure 1) clearly identifies the areas of the program and the 

relative methods of accessing them.  

 

♦ The Menus area enables the user to access any apart of the invoicing system as well as exiting 

the program. The Menus are a series of grouped functions with further sub-menus.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

♦ Step Buttons that are located on the far right are representative of the steps required for 

invoicing, making it easier for the administrator to create invoices 

♦ Drop down boxes are fields that have information requiring selection and has been entered via 

another file. To access the information click on the mouse when the pointer is over the down 

arrow on the box. This will open a look-up list that enables the operator to either scroll through 

the information or commence typing the first characters. As the first few characters are typed 

the cursor will move to the start of the alphanumeric sequence. Once the information has been 

located the user can either click using the mouse or typing the Enter key. 

 

Close 

Program 

Help 
Step 

Buttons 

Figure 1 

Minimize 

Menu 

Buttons 
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1.7 STARTING THE PROGRAM & LOGIN 
 

Launching the Invoicing software system is carried out by using the mouse to 

double click on the AxiInvoicer Icon.  

 

If you haven’t registered AxiInvoicer may ask you to register. If a key is not detected it will inform 

you with “Key not detected”. If a key is detected it will ask for a registration number. Type in your 

registration number. Contact Axion if this does continue further. 

 

Once the program starts to load on to the screen the splash screen will be displayed. The Login 

screen will appear. Ensuring the cursor is present in the USER field, type in your user name. Your 

USER name was entered in the Plant Settings at the time of installation. Using the mouse, place the 

cursor in the PASSWORD field and type in your password as was entered in the Plant Setting at the 

time of installation. The password is case sensitive and must be entered in the same manner as 

originally installed. 

 

If the USER name and PASSWORD are correct, the program will continue to load directly into the 

main screen. If the USER name and or PASSWORD are incorrect an error message will be displayed 

and the image logo will shut down and revert back to the standard Windows Desktop screen. 
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1.8 EXIT THE PROGRAM 
 

To exit the program, click on the ‘File’, ‘Exit’ menus 

command. A confirmation message will appear asking the 

‘User’ whether or not you have backed up your invoices? 

 

If the User clicks ‘Yes’ button, the program will continue to shut down. If the User clicks the ‘No’ 

button, the program will take the user to ‘step 4’ for backing up invoices. 
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CHAPTER 2 INVOICE SETUP 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.1 INVOICE SETUP 
 

This folder enables the basic setup features of the invoice to be configured. 

 

2.1.1 Lines per Page 
 

This setting indicates how many rows of the detail part of the invoice will appear on each page. This 

must be set before generation of invoices. 

 

2.1.2 Auto Print Interval Time (mSec) 
 

The time which is waited by the printer between each invoice to prevent the printer from losing print 

jobs. Recommended time is between 3 – 5 seconds depending on the printer. 

                           

2.1.3 Due Date Offset (Days)  
            

The offset used to calculate the due date on the invoice. 
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2.1.4 Next Invoice Number 
 

The very next invoice number. 

 

2.1.5 Tax Component (%) 

 

The GST Tax in (%) 

 

 

2.1.6 User Defined Invoice to Print 
 

If selected Invoicer will use the invoice that was designed in Invoice Designer, otherwise it will use 

the default invoice layout. 

 

 

2.1.7 Method of Invoice Generation 
 

This is the method of invoice generation. 

You have a combination of Customer Code or Name and/or Delivery Address and/or Delivery Date. 

 

2.1.7 Mini or Big Truck Shortfall 
 

Used to calculate the short fall. The same figure goes in here as you have in AxiBatch (Accounting 

Settings). 

 

2.1.7 Select Connection to Database 
 

This is used when in the connect screen. When connecting to an active database this points to remote 

computer and path, when remote is checked. If local is checked the path is the standard “C:\Program 

Files\AxionCS\AxiBatch\CompOrders.gdb”. The typical remote path format is 

“COMPUTERNAME:C:\\Program Files\\AxionCS\\AxiBatch\\CompOrders.gdb” 
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2.2 CONNECT  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This screen is where the user connects to an active database or backed up database and imports the 

data to the program where it can be viewed. 

 

2.2.1 Active Application Database 
 

If the user selects this option, Invoicer will connect directly to the Completed Loads Database on the 

computer running AxiBatch. This could be either remote or local. This setting is found in options. 

Once Active is selected and Date Range window appears and you can select to bring in loads within 

a certain date range. 

 

2.2.2 Backed Up Compressed Application Database 
 

If the user selects this option, Invoicer will try to open a Completed Loads Database that resides in 

the Invoicer computer and that is compressed. (The compression file with the gbk extension is 

created from AxiBatch itself ) 

 

To create a compressed completed loads file in AxiBatch either go to File->Backups or File-

>Archive and select Completed Loads Database. Once the file is created you will need to transfer the 

file to the Invoicer computer. Do not try to restore this file over the network. 

 

2.2.3 Existing Generation Invoice Database 
 

If the user selects this option, Invoicer will try to reopen an Invoice Database that was already 

created by Invoicer. This is useful to reprint an old invoice. Once loaded you can jump straight to 

step 4. 
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2.2.4 UWA Text Format Import 
 

If the user selects this option, it will import an old United Weighing file that will have load data. 

 

2.2.5 Searching 
When selected a database click ‘Search’ and find the file that is needed then click ‘open’. 

 

 
Once search has been selected a confirm box 

Will appear asking if you have backed up your  

invoices, if so click ‘Yes’ if ‘No’ the program will  

take you to ‘Step 4’ where you can back up your  

invoices. Once selected ‘Yes’ an ‘Open’ box will  

appear where a file can be selected. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To open a file click on it and it will appear highlighted and it will be displayed in the ‘File Name’ 

box. Once it has appeared there click ‘Open’ and the file will open. Note if Active Database is 

selected the search box will not open, the search criteria is set in options. 

File being 

opened 

Open File 
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This pop up box appears after a file has 

been opened and a drop down box will appear 

with the plant names select the plant name  

associated with the plant and click ‘Ok’ to  

continue. 

 
 

 

 

2.2.6       Import Data 
 

Once ‘Searched’ the program will tell you that it is ‘Ready to Import’ then click on the ‘Import 

Data’ Button. 

 

If “Merge Database” is selected the new imported records will merge into the existing database used 

in step 2, otherwise it will simply over write what is there. (I.e. existing data is deleted) 
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2.3 USERS 
 

The USERS folder allows the relevant plant personnel to enter their perspective name and associated 

passwords. When the operators Login, depending on the User level, the operator will gain access to 

the various sections of the batching system as specified. 

 

There are three User levels: Operator, Administrator & Technician. 

 

Operator Level (1): Up to twenty (20) operators and their passwords are available on this 

level. The Operator will gain access to the fundamentals of the 

batching system such as inserting and editing orders, batching and 

Materials added. 

 

Administrator Level (2): Up to ten (10) administrators and their passwords are available on this 

level. The respective user will gain access to most the levels of the 

batching system with the exception of some of the Plant Setup 

features. 

 

Technician Level (3): This level is reserved to AXION CONTROL SYSTEMS personnel 

only and gains access to all areas within the system. 

 

When entering either the User’s name and or Password the information entered will be case 

sensitive, hence if capital letters are used they must be repeated in the same manner as they were 

initially entered. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.3.1 Add User 
 

To enter a User; type in the user name of the individual in the field box exactly as required. Below 

this field box the User must type in the Password field, and repeated in the Confirm Password field. 

If the Confirm Password is not the same as when first entered, an error message will appear stating 

inconsistency and requesting the User to re-confirm the password entered. The User Level 1 for 

Operator or 2 for Administrator is selected. Once completed the Add User button is clicked. 

 

2.3 USERS (Cont…) 
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2.3.2 Change Password  
 

To avoid the risk of a particular Operator’s or Administrator’s password becoming accessible or 

familiarised with other staff it is recommended to periodically change the user’s password. To 

change a user’s password select the name by clicking on the Username drop down box. In the 

Current Password field enter the User’s existing password. In the New Password field the User must 

enter their new password keeping in mind that the characters are case sensitive. The new password 

must be confirmed in the field box below (Confirm Password) and click on the Change Password 

button and if the two entries match, the new password will be accepted. If the two entries do not 

match the error message “New Password does not match Confirm Password” will be displayed and 

the new passwords must be re-typed. 

 

2.3.3 Delete User 
 

To delete a user type the user name then the password of the user and click the “Delete User” button 

and the displayed User will be removed from the system. 

 

2.4       VIEW/EDIT IMPORTED DATA 
 

This step is for viewing and editing dockets. It is important to make sure the fields that are used to 

generate the invoices later are correct. This is the place to do it. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

Selected 

Docket  
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To Insert a docket to the list click ‘insert’ then enter the details and complete it by clicking ‘accept’ 

or ‘cancel’ to get rid of the edit. To delete a docket select the docket to delete then click ‘Delete’. 

To view each docket one by one use the arrow buttons ‘Next’ and ‘Prev’ or to go to the last docket 

click ‘Last’ or the first docket ‘First’ Make sure  you ‘Save Edited Data’ 

 

The hand to the right of Misc Description will expand the MISC items to all ten items. 

 

The idea of this step is to make sure that the fields that are used in the invoice generation criteria are 

correct. They could be any of “Customer Name or Customer Code” and or Delivery Address and or 

Delivery Date. This is set in the options screen. 

 

It is also quite easy to add the Waiting time under miscellaneous items here, by using “Tools->Insert 

Waiting Time”. 

 

You can also view the above table in order of Docket Number or ID (order of generation) by using 

“View->Completed Loads in Order By-> …”. 

 

The Sort and Range button takes you to a filtering screen that allows you to filter a date range / 

customer etc. When generation occurs it only occurs on what you filtered. The rest remains in step 2 

and will be shown after the generation step. 

 

Once everything is edited, saved and viewed click ‘Step 3-Generate’.  

 

Insert 

New 

Docket 

Delete 

Docket 

Prev and 

next 

Docket 

Go to 

first 

Docket 

Go to 

last 

Docket 
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2.5 GENERATE 
 

This is to generate new invoice database based on the selections in the following groups. To 

Generate invoices click the ‘Generate’ button and the invoices will appear in the memo box. 
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2.5 GENERATE (CONT…) 

 

 

Once generated some errors or warnings may appear with the total number of warnings, number of 

errors generated and the number of invoices generated. The user can either clear those results or save 

them to a folder by clicking the ‘Save Results To’ button. 
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2.6 VIEW/EDIT INVOICE TABLE 
 

       

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The View and edit invoices table tells the user the different invoices and how much each one costs 

depending on quantity, rate, price and GST and allows the user to make any changes before printing 

the invoices.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Invoice 
Information about 

invoice 

Change invoice, 

accept changes, and 

delete changes 
Total cost of 

invoice 
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2.7       PRINTING INVOICES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.7.1 Customer 
Print can be sorted by customer code, the customers name or all customers. 

 

2.7.2 Data Range  
Print can be sorted into the ‘date from’ to the ‘date to’ 

 

2.7.3     Invoice Range 
             Print can be sorted by invoice number ‘from’ number and ‘to’ number. 

 

Once the user has sorted the invoices for printing either select one invoice and click ‘Print Selected 

Record’ or if all the records require printing click ‘Print All Records’. 

 

 

 

 

Go to start of 

list and End of 

list 
Goes to the next 

or previous 
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2.8 EXPORT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To export invoice to accounting package select the account name from the drop box then click ‘Start 

Export’  

 

 

 

 

Select account 
Begin export 

Invoices Generated 
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2.8.1 EXPORT OPTIONS 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

The export options are selected by the user, they highlight the field then press the across button to 

transfer it to the export fields box.   

 

The Invoice window stores fields that are part of the invoice header. The Detail fields stores fields 

that are part of the invoice data (main body). The Extras are not part of the invoice but other useful 

data. 

 

Select the delimiter to use for export. 

 

Select “use Details only in Export’ if the importing software does not require header type 

information. 

 

Account 

Export Invoice  Detail 
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2.9 INVOICE SETUP 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
To change the invoice design click ‘Tools’ from the drop down menu at the top of the page, a drop 

down bar will appear and click ‘Invoice Design’ to change the design. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

INVOICE DESIGN (CONT…) 

To go to 

invoice deign 

Tools 
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2.9.1 Page Settings 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To set the layout of the Invoice click ‘Edit’ from the menu and a drop bar will appear. Click ‘Page 

Layout’ to view the ‘Page Settings’. 

 

 

To change the page settings change the  

heights and lines to add up to 297 mm if  

using the standard A4 settings. If the user 

wants to use their own settings check the  

‘User Defined’ circle under ‘Page Setup’ and 

enter the values the user wishes to use. The  

orientation can be changed by clicking the  

drop down bar next to ‘Orientation’ and either 

selecting ‘Portrait’ or ‘Landscape’. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

INVOICE DESIGN (CONT…) 

 

Edit 

Page Layout 
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User 
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setup 
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2.9.2 Adding Fields to Invoice 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To add new fields right click in the header or footer and a drop down bar will appear, click ‘Add’ 

and select the sort of field needed and a ‘Field Properties’ window should appear.  

 

 

 

 

 

 

 

In the ‘Field Properties’ window the type of field can 

be changed by clicking the drop down bar of ‘Type’.  

when Text is selected, text can be written into the  

‘Text’ box. The alignment of the text can be changed 

by clicking the ‘Alignment’ drop down box and  

selecting the alignment required. The ‘Font’ of the  

text can be changed by clicking ‘Font’. To change  

the coordinates type in the value for ‘X’ and ‘Y’ and  

the text will move around the page.   

 

 

 

 

 

 

 

 

INVOICE DESIGN (CONT…) 
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field to 

Invoice 

Different 

fields 



Axi-Invoicer Computerised Invoicing System – Operating Manual 

Axiinvoicer_Manual_Main V1_1.doc©2009   Axion Control Systems Pty Ltd Page 23 of 27 

 

In the ‘Field Properties’ window the type of field can 

be changed by clicking the drop down bar of ‘Type’.  

when ‘Invoice Field’ is selected, the Invoice Field can be 

changed by clicking the drop down bar and selecting the  

field. The alignment of the text can be changed 

by clicking the ‘Alignment’ drop down box and  

selecting the alignment required. The ‘Font’ of the  

text can be changed by clicking ‘Font’. To change  

the coordinates type in the value for ‘X’ and ‘Y’ and  

the text will move around the page.     

 

 

 

 

 

• INVOICE_CUSTOMER_ADDRESS1: The customer’s first address. 

• INVOICE_CUSTOMER_ADDRESS2: The customer’s second address. 

• INVOICE_CUSTOMER_ADDRESS3: The customer’s third address. 

• INVOICE_CUSTOMER_ADDRESS4: The customer’s forth address.  

• INVOICE_CUSTOMER_CODE: The customer’s code. 

• INVOICE_CUSTOMER_NAME: The customer’s name. 

• INVOICE_DUE_DATE: The due date of payment. 

• INVOICE_ID: 

• INVOICE_NO_LINES: 

• INVOICE_NO_PAGES: 

• INVOICE_NUMBER: 

• INVOICE_ORDER_NO: The order number. 

• INVOICE_PREFIX: 

• INVOICE_TOTAL_AMOUNT_PAYABLE: 

• INVOICE_TOTAL_DUE: The total amount that needs to be paid. 

• INVOICE_TOTAL_GST:  

• INVOICE_TOTAL_PRICE: 

• INVOICE_TOTAL_QTY: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

INVOICE DESIGN (CONT…) 
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In the ‘Field Properties’ window the type of field can 

be changed by clicking the drop down bar of ‘Type’. 

When ‘Detailed Field’ is selected, the Detail Field can be  

changed by clicking the drop down bar and selecting the  

field. The alignment of the text can be changed 

by clicking the ‘Alignment’ drop down box and  

selecting the alignment required. The ‘Font’ of the  

text can be changed by clicking ‘Font’. To change  

the coordinates type in the value for ‘X’ and ‘Y’ and  

the text will move around the page.    

when 

 

 

 

• DETAIL_DELIVERY_DATE: The date that the goods with be delivered. 

• DETAIL_DESCRIPTION: 

• DETAIL_DOCKET_NO: The docket number. 

• DETAIL_GST: How much GST is charged. 

• DETAIL_ID: 

• DETAIL_INVOICE_ID: 

• DETAIL_LINE_NO: Line numbers. 

• DETAIL_PAGE_NO: Page numbers. 

• DETAIL_PLANT_NAME: The name of the plant. 

• DETAIL_PRICE: The pricing. 

• DETAIL_QUANTITY: How many of a particular item. 

• DETAIL_RATE: 

• DETAIL_SCOPE: 

• DETAIL_TOTAL: The totals. 

 

 

 

In the ‘Field Properties’ window the type of field can 

be changed by clicking the drop down bar of ‘Type’. 

When ‘System Field’ is selected, the System Field can be  

changed by clicking the drop down bar and selecting the  

field. The alignment of the text can be changed 

by clicking the ‘Alignment’ drop down box and  

selecting the alignment required. The ‘Font’ of the  

text can be changed by clicking ‘Font’. To change  

the coordinates type in the value for ‘X’ and ‘Y’ and  

the text will move around the page.  

 

 

 

• DATE: The date. 

• PAGE: The page number. 

• TIME: The time. 

 

INVOICE DESIGN (CONT…) 
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2.9.3 Font 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To change the font scroll through each of the windows ‘Font’, ‘Font Style’, ‘Size’ and ‘Colour’ then 

select the styles you want, when finished selecting click ‘OK’ to accept the changes. 

2.9.4 Preview Invoice 
 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To view a preview of the Invoice click ‘File’ and a drop down bar will appear then click on 

‘Preview’ and a preview of the invoice will appear.  

 

Font 

Font Style  

Font Size  

Font Colour 

Accept font 

changes  

Preview 

First Page 

Zoom to Width 

Save and Open 

Last Page 

Zoom to 

100% 
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When saving an invoice layout it saves in the format of (.QRP) Quick Report File. When opening a 

Preview the file also needs to be the format of (.QRP). 

 

 

 

 

 

 
 

 

 

 

 

 

 

2.9.5 Save Invoice Settings 
 

 

 

Save Settings 
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To save invoice settings click ‘File’ in the menu and a drop down bar will appear. Click on ‘Save 

Settings’ and the invoice layout will be saved. 

 


